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SUMMARY

This guide is a troubleshooting reference used for maintaining and servicing the computer. It provides
comprehensive information on identifying computer features, components, and spare parts;
troubleshooting computer problems; and performing computer disassembly procedures.
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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product name HP Mini 5102

Processor Intel® Atom™ N470 1.83-GHz processor, 512-KB Level 2 cache, 667-MHz front-
side bus (FSB)

 Intel Atom N450 1.66-GHz processor, 512-KB Level 2 cache, 667-MHz front-side
bus (FSB)

Chipset Intel® NM10 Express

Graphics Intel® Universal Memory Architecture (UMA) graphics subsystem

 Broadcom Crystal HD Enhanced Video Decoder (32 MB × 16 DDR2) optional

NOTE: Not supported by computers with WWAN option installed.

Panel Wide-aspect 16:9 ratio panels

All display assemblies include 1 webcam, 2 microphones, and 2 wireless local-
area network (WLAN) antennas/cables (WWAN is optional).

 Capacitive touch screen optional

 25.7-cm (10.1-in) high-definition (1366 × 768) AntiGlare LED

 25.7-cm (10.1-in) standard-definition (1024 × 600) AntiGlare LED

Memory One customer-accessible/upgradable memory module slot

 Supports up to 2 GB of system memory

 PC2-5300, 800 MHz, DDR2 (running at 667-MHz)

 Supports the following configurations:

 ● 2048-MB total system memory (2048 × 1)

NOTE: Not supported by computers with Windows® XP Home or with Windows
7 Starter .

 ● 1024-MB total system memory (1024 × 1)

Mass storage devices  Hard drive

 Supports the following 9.5-mm, 6.35-cm (2.50-in) SATA hard drives:
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Category Description

 ● 320-GB, 7200-RPM

NOTE: Not supported by computers with Windows® XP Home or with Windows
7 Starter in select countries and regions.

 ● 250-GB, 7200-RPM

NOTE: Not supported by computers with Windows® XP Home.

 ● 160-GB, 7200-RPM

 Solid state drive (SSD)

 Supports the following 6.35-cm (2.50-in) SATA solid state drives:

 ● 80 GB

NOTE: Not supported by computers with Windows® XP Home or with Windows
7 Starter.

 ● 128 GB

NOTE: Not supported by computers with Windows® XP Home or with Windows
7 Starter.

Optical drive Supports external USB optical drives only

Diskette drive Supports external USB diskette drives only

Audio/Visual High-definition (HD) audio

 Integrated speakers (2)

 Fixed integrated stereo microphones (2)

 Fixed integrated 2-MP webcam

Modem Supports external USB modems only

Ethernet Integrated 10/100/1000 Wake-On-LAN network interface card (NIC)

Wireless 2 WLAN antennas built into display assembly. WWAN antennas (2) with WWAN
option (worldwide 5-band antenna configured with select models)

 Integrated WLAN modules:

● 802/11/a/b/g/n

● 802.11 b/g/n

● 802.11b/g with Bluetooth

● 802.11 b/g

 Support for No WLAN option

 Integrated WWAN option

NOTE: Not supported by computers with Linux installed.

NOTE: Not supported by computers with HD Enhanced Video Accelerator
installed.
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Category Description

 Integrated WPAN Bluetooth® module

 Support for No WPAN option.

External media cards Media Card Reader with push-push technology supporting:

● MultiMediaCard (MMC)

● Secure Digital (SD) Memory Card

Ports Audio-in (stereo microphone)

 Audio out (stereo headphone)

 RJ-45 (Ethernet, includes link and activity lights)

 USB (2)

 USB+ (powered) (1)

 VGA (D-sub 15) supporting 1920 × 1440 external monitor (hot plug/unplug with
auto-detect)

 3-pin AC power

Keyboard/pointing device 92%, spill-resistant keyboard

 Dura-Keys

 TouchPad, with 2 TouchPad buttons and 2-way scrolling (taps enabled as default)

Power requirements AC adapter

● 65-W Smart AC adapter

● 40-W Smart AC adapter

NOTE: AC adapter includes connector on cable and localized plug support.

 Battery

● 6 cell Li-Ion (66-Wh) 3.0-Ah

● 6 cell Li-ion (55-Wh) 2.55-Ah

● 4-cell Li-ion (29-Wh) 2.0-Ah

Security Supports HP Kensington Security Lock

Operating system Preinstalled:

 Windows 7 Professional 32

 Windows 7 Professional 32 with Windows XP Pro images

 Windows 7 Home Premium

 Windows 7 Starter

 Windows XP Home SP3 for NetBooks

 FreeDOS
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Category Description

 SUSE Linux (SLED 11)

Serviceability Customer Self-Replacement (CSR):

● AC adapter

● Battery (system)

● Keyboard

● Memory module

● Hard drive
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2 External component identification

Components included with the computer may vary by region and model. The illustrations in this chapter
identify the standard features on most computer models.

To see a list of hardware installed in the computer, follow these steps:

▲ Select Start > Control Panel > System and Security > Device Manager.

You can also add hardware or modify device configurations using Device Manager.

NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
applications, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Top components
TouchPad

Component Description

(1) TouchPad* Moves the pointer and selects or activates items on the screen.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) Right TouchPad button* Functions like the right button on an external mouse.

(4) TouchPad scroll zone Scrolls up or down.

*This table describes factory settings. To view or change pointing device preferences, select Start > Devices and Printers.
Then, right-click the device representing your computer, and select Mouse settings.
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Lights

Component Description

(1) Caps lock light On: Caps lock is on.

(2) QuickWeb light On: The Web browser is in use.

(3) QuickLook light ● On: The computer is on.

● Off: The computer is off or in Sleep or Hibernation.

(4) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.
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Buttons

Component Description

(1) QuickWeb button ● When the computer is off, press the button to open
HP QuickWeb.

● When the computer is on, press the button to open
the default Web browser.

(2) QuickLook button ● When the computer is off, press the button to open
HP QuickLook.

● When the computer is on, press the button to open
Software Setup.

NOTE: If Software Setup is not available, the default
Web browser opens.

(3) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button to shut
down the computer.

● When the computer is in the Sleep state, press the
button briefly to exit Sleep.

● When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power
Options.
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Keys

Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Displays system information when pressed in combination with the
esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute the action represented by the icon on the key.
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Front components

Component Description

(1) Drive light Blinking: The hard drive is being accessed.

(2) Wireless light ● Blue: An integrated wireless device, such as a wireless local
area network (WLAN) device and/or a Bluetooth® device, is
on.

● Amber: All wireless devices are off.

NOTE: The wireless light turns amber when the computer turns
on and all wireless devices are off.

(3) Wireless switch Turns the wireless feature on or off, but does not create a wireless
connection.

NOTE: To establish a wireless connection, a wireless network
must already be set up.

(4) Speakers (2) Produce sound.
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Right-side components

Component Description

(1) SD Card Reader Supports the following optional digital card formats:

● MultiMediaCard (MMC)

● Secure Digital (SD) Memory Card

(2) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(3) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

(4) Powered USB port Provides power to a USB device, such as an optional external
optical drive, if used with a powered USB cable.

(5) RJ-45 (network) jack Connects a network cable.

(6) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but it
may not prevent the computer from being mishandled or stolen.
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Left-side components

Component Description

(1) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level..

(2) Power connector Connects an AC adapter.

(3) External monitor port Connects an external VGA monitor or projector.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5) USB ports (2) Connect optional USB devices.
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Display components 

Component Description

(1) Webcam light On: The webcam is in use.

(2) Webcam Records audio and video and captures still photographs.

(3) Internal microphones (2) Record sound.

NOTE: If there is a microphone icon next to each microphone
opening, your computer has internal microphones.
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Bottom components

Component Description

(1) Battery bay Holds the battery.

(2) Battery release latches (2) Release the battery from the battery bay.

(3) SIM slot (select models only) Contains a wireless subscriber identity module (SIM).

(4) Service tag Provides the product brand and series name, serial number (s/n),
and product number (p/n) of your computer. Have this information
available when you contact technical support.

(5) Memory module compartment Contains the memory module slot.

(6) Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.
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Carrying handle
Select models of the computer have an optional carrying handle that is attached to the bottom of the
computer. The handle can be extended by rotating it away from the computer as shown in the
following illustration.
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Wireless antennas
On select models of the computer, at least 2 antennas send and receive signals from one or more
wireless devices.

Component Description

(1) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with
wireless wide-area networks (WWANs).

(2) WLAN antennas (2)* (select models only) Send and receive wireless signals to communicate with
wireless local area networks (WLANs).

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.
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Additional hardware components

Component Description

(1) Power cord* Connects an AC adapter to an AC outlet.

(2) AC adapter Converts AC power to DC power.

(3) Battery* Powers the computer when the computer is not plugged into
external power.

*Batteries and power cords vary in appearance by region and country.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag located on the bottom of the computer.

NOTE: Service tag color varies on select models.

(1) Product name (4) Warranty period

(2) Serial number (5) Model description (select models)

(3) Product number  

NOTE: Warranty and Model fields may be excluded from the service tag on select models.
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Device major components
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Item Description Spare part
number

(1) Display panel assembly (includes 1 webcam, 2 microphones, and 2 WLAN antennas
with cables; 2 WWAN antennas with cables on select models)

See Display assembly components on page 26 for a comprehensive list of display
assembly spare parts.

 

 ● 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use with
webcam and WWAN option, black

598456-001

 ● 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use with
webcam and WWAN option, red

607178-001

 ● 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use with
webcam and WWAN option, blue

607180-001

 ● 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use with
webcam, black

598454-001

 ● 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with webcam
and WWAN option, black

580616-001

 ● 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with webcam
and WWAN option, red

607182-001

 ● 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with webcam
and WWAN option, blue

607184-001

 ● 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with webcam 577969-001

 ● 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with webcam and
WWAN option, black

598455-001

 ● 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with webcam and
WWAN option, red

607177-001

 ● 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with webcam and
WWAN option, blue

607179-001

 ● 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with webcam 598453-001

 ● 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with webcam and
WWAN option, black

580615-001

 ● 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with webcam and
WWAN option, red

607181-001

 ● 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with webcam and
WWAN option, blue

607183-001

 ● 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with webcam 577968-001

(2) Keyboard, 25.7 cm (10.1 in)

 ● For use in Belgium 578364-A41

 ● For use in Brazil 578364-201

 ● For use in Bulgaria 578364-261

 ● For use in the Czech Republic 578364-221
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Item Description Spare part
number

 ● For use in Denmark 578364-081

 ● For use in Europe 578364-B31

 ● For use in France 578364-051

 ● For use in French Canada 578364-121

 ● For use in Finland, and Sweden 578364-B71

 ● For use in Germany 578364-041

 ● For use in Greece 578364-DJ1

 ● For use in Hungary 578364-211

 ● For use in Iceland 578364-DD1

 ● For use in Israel 578364-BB1

 ● For use in Italy 578364-061

 ● For use in Japan 578364-291

 ● For use in Latin America 578364-161

 ● For use in Norway 578364-091

 ● For use in Portugal 578364-131

 ● For use in Russia 578364-251

 ● For use in Saudi Arabia 578364-171

 ● For use in Slovakia 578364-231

 ● For use in Slovenia 578364-BA1

 ● For use in South Korea 578364-AD1

 ● For use in Spain 578364-071

 ● For use in Switzerland 578364-BG1

 ● For use in Taiwan 578364-AB1

 ● For use in Thailand 578364-281

 ● For use in Turkey 578364-141

 ● For use in the United Kingdom 578364-031

 ● For use in the United States 578364-001

(3) Top cover (includes TouchPad)  

 ● Black 577926-001

 ● Red 598461-001

 ● Blue 598462-001

(4) Speaker assembly (includes cable) 577967-001
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Item Description Spare part
number

(5) Hard drive

NOTE: Hard drive spares include mounting bracket and screws.

 ● 320-GB, 7200-RPM, for use with WWAN option 593643-001

 ● 320-GB, 7200-RPM, SATA 577974-001

 ● 250-GB, 7200-RPM, for use with WWAN option 593642-001

 ● 250-GB, 7200-RPM, SATA 577973-001

 ● 160-GB, 7200-RPM, for use with WWAN option 593641-001

 ● 160-GB, 7200-RPM, SATA 577972-001

 Solid state drive (SSD)

NOTE: Solid state drive spares include mounting bracket and screws.

 

 ● 128-GB, SATA 606971-001

 ● 80-GB, SATA 583004-001

(6) Fan and heat sink assembly (includes replacement thermal material) 598452-001

(7) WLAN module  

 Broadcom 4312G 802.11b/g WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)

575920-001

 Broadcom 43224 802.11a/b/g/n 2x2 WiFi Adapter  

 ● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands,
Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

518434-001
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Item Description Spare part
number

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Argentina, Armenia,
Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong
Kong, Hungary, Iceland, India, Indonesia, Ireland, Italy, the Ivory Coast, Jamaica,
Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands,
New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, the People’s Republic of China, Peru, the Philippines,
Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South
Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand,
Togo, Tonga, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

518434-002

 Intel Centrino Wireless-N 1000 802.11b/g/n 1x2

 ● For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria,
Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia, Brazil,
Brunei, Bulgaria, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El
Salvador, Estonia, Finland, France, French Guiana, Georgia, Germany, Ghana,
Greece, Guadeloupe, Guam, Guatemala, Haiti, Herzegovina, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco,
Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Nigeria, Norway, Oman, Panama, Paraguay, the People’s Republic China, Peru, the
Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi Arabia,
Senegal, Serbia, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain,
Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, the
United Arab Emirates, the United Kingdom, Uruguay, the U.S. Virgin Islands, the United
States, Venezuela, and Vietnam

572520-001

 ● For use in Russia and Ukraine 585984-001

 Broadcom 4312G 802.11b/g WiFi Adapter  

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and the
U.S. Virgin Islands

504593-003
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Item Description Spare part
number

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African
Republic, Chad, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan,
Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru,
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria,
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

504593-004

(8) System board (includes processor, replacement thermal material, and RTC battery)  

 ● Includes Intel Atom N470 1.83-GHz processor, 512-KB Level 2 cache, 667-MHz front-
side bus (FSB)

598449-001

 ● Includes Intel Atom N470 1.83-GHz processor, 512-KB Level 2 cache, 667-MHz front-
side bus (FSB) for use in the People's Republic of China

598450-001

 ● Includes Intel Atom N450 1.66-GHz processor, 512-KB Level 2 cache, 667-MHz front-
side bus (FSB)

598447-001

 ● Includes Intel Atom N450 1.66-GHz processor, 512-KB Level 2 cache, 667-MHz front-
side bus (FSB) for use in the People's Republic of China

598448-001

Plastics kit with Bluetooth cable 605743-001

 (9a) Bluetooth cable  

 (9b) Audio connector cover  

 (9c) Memory module compartment cover  

 (9d) Blank for Media Card Reader  

(10) Bluetooth module 537921-001

(11) RTC battery 507707-001

(12) Optional minicard:  
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Item Description Spare part
number

 WWAN module, Qualcomm EV-DO HSPA (includes mounting bracket)

NOTE: Not supported by computers with Linux installed.

NOTE: Not supported by computers with the HD Enhanced Video Accelerator installed.

531993-001

 HD Enhanced Video Accelerator (graphics decoder) 578237-001

(13) Power button board (includes cable) 598451-001

(14) SIM board (includes cable) 577923-001

(15) Battery  

 ● 6 cell Li-ion (66 Wh) 3.0 Ah 535629-001

 ● 6 cell Li-ion (55 Wh) 2.55 Ah 579027-001

 ● 4-cell Li-ion (29-Wh) 2.0-Ah 579026-001

(16) Base enclosure (includes 4 rubber device feet) 607111-001

(17) Memory module (PC2-6400, shared)  

 ● 2048-MB

NOTE: Not supported by computers with Windows® XP Home SP3, or with Windows
7 Starter installed.

598858-001

 ● 1024-MB 598861-001
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Display assembly components
NOTE: The first figure below shows the non-touch display assembly and the second figure shows the
touch-screen display assembly.

NOTE: The following figure shows the components of the touch-screen display assembly. The display
bezel thickness increases to accommodate the touch-screen glass and board.

Item Description Spare part number

(1) Display bezel  

 ● For use with touch screen with webcam 598460-001
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Item Description Spare part number

 ● For use with non-touch screen with webcam 577929-001

(2) Display hinge kit

(Includes left and right display panel hinges)

577930-001

(3) LCD panel

NOTE: The non-touch display assembly includes the LCD panel. See the display
assembly part number in Device major components on page 19.

 

 ● LCD with touch glass for use with high definition display assembly 607113-001

 ● LCD with touch glass for use with WSVGA display assembly 607112-001

(4) Webcam module 577927-001

(5) Display panel/webcam cable  

 ● For use in high-definition display assembly 577932-001

 ● For use in WSVGA display assembly 577931-001

 Display cable kit includes the following cables: 577933-001

(6) ● WLAN antennas (2) with cable  

(7) ● Dual microphone with cable  

(8) ● WWAN antennas (2) with cable

(9) Display back cover (includes logo)  

 ● Black for use with touch screen 598457-001

 ● Red for use with touch screen 598458-001

 ● Blue for use with touch screen 598459-001

 ● Black for use with non-touch screen 577928-001

 ● Red for use with non-touch screen 606201-001

 ● Blue for use with non-touch screen 606970-001
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Miscellaneous parts
Description Spare part number

65-W, 3-pin Smart AC adapter  

● For use in all countries and regions except India 463958-001

● For use in India 577170-001

40-W, 3-pin Smart AC adapter (for use in all countries and regions) 583186-001

Power cord

● For use in Argentina 490371-D01

● For use in Australia 490371-011

● For use in Brazil 490371-201

● For use in Denmark 490371-081

● For use in Europe 490371-021

● For use in India 490371-D61

● For use in Israel 490371-BB1

● For use in Italy 490371-061

● For use in Japan 490371-291

● For use in North America 490371-001

● For use in the People's Republic of China 490371-AA1

● For use in Singapore and the United Kingdom 490371-031

● For use in South Africa 490371-AR1

● For use in South Korea 490371-AD1

● For use in Switzerland 490371-111

● For use in Taiwan 490371-AB1

Rubber kit (contains 4 rubber device feet – 2 front and 2 rear) 578361-001
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Description Spare part number

Optional carrying handle (see Carrying handle on page 15) 606384-001

Screw kit 

Includes the following replacement screws:

● PM1.6×2.5×3.5

● PM2.0×2.0×6.8 broad head

● PM2.0×2.5

● PM2.0×3.0×4.0

● PM2.0x2.5x4.5

● PM2.5×4.0

● PM2.5×5.0×5.5

● PM2.6×4.5

578362-001
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Sequential part number listing
Spare part number Description

463958-001 65-W, 3-pin Smart AC adapter for use in all countries and regions except India

490371-001 Power cord for use in North America

490371-011 Power cord for use in Australia

490371-021 Power cord for use in Europe

490371-031 Power cord for use in Singapore and the United Kingdom

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

504593-003 Broadcom 4312G 802.11b/g WiFi Adapter for use in Canada, the Cayman Islands, Guam, Puerto
Rico, the United States, and the U.S. Virgin Islands
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Spare part number Description

504593-004 Broadcom 4312G 802.11b/g WiFi Adapter for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan,
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China,
Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

507707-001 RTC battery

518434-001 WLAN module, Broadcom 43224 802.11a/b/g/n 2x2 WiFi Adapter for use in Antigua and
Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago,
the U.S. Virgin Islands, and the United States

518434-002 WLAN module, Broadcom 43224 802.11a/b/g/n 2x2 WiFi Adapter for use in Afghanistan,
Albania, Algeria, Andorra, Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan,
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Italy, the Ivory
Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People’s Republic of China,
Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe
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Spare part number Description

531993-001 Optional WWAN module, Qualcomm EV-DO HSPA (includes mounting bracket)

NOTE: Not supported by computers with Linux installed.

NOTE: Not supported by computers with HD Enhanced Video Accelerator installed.

535629-001 Battery, 6 cell Li-ion (66 Wh) 3.0 Ah

537921-001 Bluetooth module

572520-001 Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 for use in Andorra, Antigua and Barbuda,
Argentina, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda,
Bolivia, Bosnia, Brazil, Brunei, Bulgaria, Canada, the Cayman Islands, Chile, Colombia, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El
Salvador, Estonia, Finland, France, French Guiana, Georgia, Germany, Ghana, Greece,
Guadeloupe, Guam, Guatemala, Haiti, Herzegovina, Honduras, Hong Kong, Hungary, Iceland,
India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait,
Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta,
Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Panama, Paraguay, the People’s
Republic China, Peru, the Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino,
Saudi Arabia, Senegal, Serbia, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain,
Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, the United Arab
Emirates, the United Kingdom, Uruguay, the U.S. Virgin Islands, the United States, Venezuela, and
Vietnam

575920-001 WLAN module, Broadcom 4312G 802.11b/g WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)

577170-001 65-W, 3-pin Smart AC adapter for use in India

577923-001 SIM board with cable

577926-001 Top cover with TouchPad, black

577927-001 Webcam module

577928-001 Display back cover with logo for use with non-touch screen, black

577929-001 Display bezel for use with non-touch screen with webcam

577930-001 Display hinge kit (includes left and right display panel hinges and screws)

577931-001 Display panel/webcam cable for use in WSVGA display assembly

577932-001 Display panel/webcam cable for use in high-definition display assembly

577933-001 Display cable kit with the WLAN antennas (2) and cable, dual array microphone with cable, and
WWAN antennas (2) with cable on select models.

577967-001 Speaker assembly with cable

577968-001 Display panel assembly, 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with
webcam

577969-001 Display panel assembly, 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with
webcam

577972-001 Hard drive, 160-GB, 7200-RPM, SATA

577973-001 Hard drive, 250-GB, 7200-RPM, SATA
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Spare part number Description

577974-001 Hard drive, 320-GB, 7200-RPM, SATA

578237-001 HD Enhanced Video Accelerator (graphics decoder)

578361-001 Rubber kit (contains 2 front and 2 rear rubber device feet)

578362-001 Screw kit

578364-001 Keyboard, 25.7-cm (10.1-in) for use in the United States

578364-031 Keyboard, 25.7-cm (10.1-in) for use in the United Kingdom

578364-041 Keyboard, 25.7-cm (10.1-in) for use in Germany

578364-051 Keyboard, 25.7-cm (10.1-in) for use in France

578364-061 Keyboard, 25.7-cm (10.1-in) for use in Italy

578364-071 Keyboard, 25.7-cm (10.1-in) for use in Spain

578364-081 Keyboard, 25.7-cm (10.1-in) for use in Denmark

578364-091 Keyboard, 25.7-cm (10.1-in) for use in Norway

578364-121 Keyboard, 25.7-cm (10.1-in) for use in French Canada

578364-131 Keyboard, 25.7-cm (10.1-in) for use in Portugal

578364-141 Keyboard, 25.7-cm (10.1-in) for use in Turkey

578364-161 Keyboard, 25.7-cm (10.1-in) for use in Latin America

578364-171 Keyboard, 25.7-cm (10.1-in) for use in Saudi Arabia

578364-201 Keyboard, 25.7-cm (10.1-in) for use in Brazil

578364-211 Keyboard, 25.7-cm (10.1-in) for use in Hungary

578364-221 Keyboard, 25.7-cm (10.1-in) for use in the Czech Republic

578364-231 Keyboard, 25.7-cm (10.1-in) for use in Slovakia

578364-251 Keyboard, 25.7-cm (10.1-in) for use in Russia

578364-261 Keyboard, 25.7-cm (10.1-in) for use in Bulgaria

578364-281 Keyboard, 25.7-cm (10.1=in) for use in Thailand

578364-291 Keyboard, 25.7-cm (10.1-in) for use in Japan

578364-A41 Keyboard, 25.7-cm (10.1-in) for use in Belgium

578364-AB1 Keyboard, 25.7-cm (10.1-in) for use in Taiwan

578364-AD1 Keyboard, 25.7-cm (10.1-in) for use in South Korea

578364-B31 Keyboard, 25.7-cm (10.1-in) for use in Europe

578364-B71 Keyboard, 25.7-cm (10.1-in) for use in Finland, and Sweden

578364-BA1 Keyboard, 25.7-cm (10.1-in) for use in Slovenia

578364-BB1 Keyboard, 25.7-cm (10.1-in) for use in Israel
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578364-BG1 Keyboard, 25.7-cm (10.1-in) for use in Switzerland

578364-DD1 Keyboard, 25.7-cm (10.1-in) for use in Iceland

578364-DJ1 Keyboard, 25.7-cm (10.1 in) for use in Greece

579026-001 Battery, 4-cell Li-ion (29-Wh) 2.0-Ah

579027-001 Battery, 6-cell Li-ion battery (55-Wh) 2.55-Ah

580615-001 Display panel assembly, 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with
webcam and WWAN option, black

580616-001 Display panel assembly, 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with
webcam and WWAN option, black

583004-001 Solid state drive (SSD), 80-GB, SATA

583186-001 40-W, 3-pin, Smart AC adapter for use in all countries and regions

585984-001 Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 for use in Russia and Ukraine

593641-001 Hard drive, 160-GB, 7200-RPM, for use with WWAN option

593642-001 Hard drive, 250-GB, 7200-RPM, for use with WWAN option

593643-001 Hard drive, 320-GB, 7200-RPM, for use with WWAN option

598447-001 System board (including replacement thermal material and RTC battery), Intel Atom N450 1.66-GHz
processor, 512-KB Level 2 cache, 667-MHz front-side bus (FSB)

598448-001 System board (including replacement thermal material and RTC battery), Intel Atom N450 1.66-GHz
processor, 512-KB Level 2 cache, 667-MHz front-side bus (FSB) for use in the People's Republic of
China

598449-001 System board (including replacement thermal material and RTC battery), Intel Atom N470 1.83-GHz
processor, 512-KB Level 2 cache, 667-MHz front-side bus (FSB)

598450-001 System board (including replacement thermal material and RTC battery), Intel Atom N470 1.83-GHz
processor, 512-KB Level 2 cache, 667-MHz front-side bus (FSB) for use in the People's Republic of
China

598451-001 Power button board with cable

598452-001 Fan and heat sink assembly with replacement thermal material

598453-001 Display panel assembly, 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with
webcam

598454-001 Display panel assembly, 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use
with webcam, black

598455-001 Display panel assembly, 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with
webcam and WWAN option, black

598456-001 Display panel assembly, 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use
with webcam and WWAN option, black

598457-001 Display back cover with logo for use with touch screen, black

598458-001 Display back cover with logo for use with touch screen, red

34 Chapter 3   Illustrated parts catalog



Spare part number Description

598459-001 Display back cover with logo for use with touch screen, blue

598460-001 Display bezel for use with touch screen with webcam

598461-001 Top cover with TouchPad, red

598462-001 Top cover with TouchPad, blue

598858-001 Memory module, PC2-6400, shared, 2048-MB

NOTE: Not supported by computers with Windows® XP Home SP3, or with Windows 7 Starter
installed.

598861-001 Memory module, PC2-6400, shared, 1024-MB

605743-001 Plastics kit with Bluetooth cable

606201-001 Display back cover with logo for use with non-touch screen, red

606384-001 Optional carrying handle

606970-001 Display back cover with logo for use with non-touch screen, blue

606971-001 Solid state drive (SSD), 128-GB, SATA

607111-001 Base enclosure (includes 2 front and 2 rear device feet)

607112-001 LCD with touch glass for use with WSVGA display assembly

607113-001 LCD with touch glass for use with high definition display assembly

607177-001 Display panel assembly, 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with
webcam and WWAN option, red

607178-001 Display panel assembly, 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use
with webcam and WWAN option, red

607179-001 Display panel assembly, 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with
webcam and WWAN option, blue

607180-001 Display panel assembly, 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use
with webcam and WWAN option, blue

607181-001 Display panel assembly, 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with
webcam and WWAN option, red

607182-001 Display panel assembly, 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with
webcam and WWAN option, red

607183-001 Display panel assembly, 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with
webcam and WWAN option, blue

607184-001 Display panel assembly, 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with
webcam and WWAN option, blue
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4 Removal and replacement
procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the device, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.

Cables and connectors

CAUTION: When servicing the device, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the device.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
device, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the device. If you are unsure whether the device
is off or in Hibernation, turn the device on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the device when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

38 Chapter 4   Removal and replacement procedures



Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V

40 Chapter 4   Removal and replacement procedures



Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 65 screws, in 9 different sizes, that must be removed, replaced, or loosened
when servicing the device. Make special note of each screw size and location during removal and
replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag located on the bottom of the computer.

NOTE: Service tag color varies on select models.

(1) Product name: This is the product name affixed to the front of the device.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Warranty: This number describes the duration of the warranty period for the device.

(5) Model: This is the alphanumeric identifier used to locate documents, drivers, and support for the
device.

NOTE: Warranty and Model fields may be excluded from the service tag on select models.
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Device feet
The device feet are adhesive-backed rubber pads. The rear feet are attached and the front feet are
tethered to the bottom of the base enclosure.

NOTE:  The front and rear device feet are not interchangeable. Due to the adhesive nature of the
rubber pads, they should be replaced after removal.

NOTE: The rear device feet may not be applied on models that use the optional carrying handle (see
Carrying handle on page 15).

Description Spare part number

Rubber kit (contains 4 rubber device feet – 2 front and 2 rear) 578361-001
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Battery

Description Spare part number

6 cell Li-ion (66 Wh) 3.0 Ah 535629-001

6 cell Li-ion battery (55 Wh) 2.55 Ah 579027-001

4-cell Li-ion (29-Wh) 2.0-Ah 579026-001

Before removing the battery, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

Remove the battery:

1. Turn the device upside down on a flat surface with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2).

Reverse this procedure to install a battery.
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SIM
NOTE: This section applies only to device models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to insert the SIM.
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Memory module

Description Spare part number

Memory module, PC2-6400, shared, 2048-MB

NOTE: Not supported by computers with Windows® XP Home SP3, or with Windows 7 Starter
installed.

598858-001

Memory module, PC2-6400, shared, 1024-MB 598861-001

Before removing the memory module, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

Remove the memory module:

1. With the battery removed, slide the battery release latch in front of the memory module
compartment (1) to release the memory module cover from the computer.

2. Swing the cover up and away from the outside of the computer to remove the cover (2).

3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The module tilts up.)
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4. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Keyboard

Description Spare part number

For use in Belgium 578364-A41

For use in Brazil 578364-201

For use in Bulgaria 578364-261

For use in the Czech Republic 578364-221

For use in Denmark 578364-081

For use in Europe 578364-B31

For use in France 578364-051

For use in French Canada 578364-121

For use in Finland, and Sweden 578364-B71

For use only in Germany 578364-041

For use in Greece 578364-DJ1

For use in Hungary 578364-211

For use in Iceland 578364-DD1

For use in Israel 578364-BB1

For use in Italy 578364-061

For use in Japan 578364-291

For use in Latin America 578364-161

For use in Norway 578364-091

For use in Portugal 578364-131

For use in Russia 578364-251

For use in Saudi Arabia 578364-171

For use in Slovakia 578364-231

For use in Slovenia 578364-BA1

For use in South Korea 578364-AD1

For use in Spain 578364-071

For use in Switzerland 578364-BG1

For use in Taiwan 578364-AB1

For use in Thailand 578364-281

For use in Turkey 578364-141

For use in the United Kingdom 578364-031

For use only in the United States 578364-001

Component replacement procedures 47



Before removing the keyboard, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

Remove the keyboard:

1. Remove the 3 Phillips PM2.0×3.0 screws that secure the keyboard to the device.

2. Open the display 90 degrees.

3. Use a tool to push the screw tabs directly down to release the rear edge of the keyboard.

4. Turn the device right-side up, and then lift up on the left and right retention tabs (1) of the
keyboard until the keyboard releases.
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5. Swing the keyboard forward (2), and slide the keyboard back until its top edge rests on the
display assembly (3).

NOTE: You can also rest the keyboard upside down on the palm rest to access the keyboard
cable.

6. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached.

7. Disconnect the cable (2).

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Mass storage devices
NOTE: Each hard drive spare part kit and solid state drive spare part kit includes a bracket and
screws.

Description Spare part number

Hard drive, 320-GB, 7200-RPM, for use with WWAN option 593643-001

Hard drive, 320-GB, 7200-RPM, SATA 577974-001

Hard drive, 250-GB, 7200-RPM, for use with WWAN option 593642-001

Hard drive, 250-GB, 7200-RPM, SATA 577973-001

Hard drive, 160-GB, 7200-RPM, for use with WWAN option 593641-001

Hard drive, 160-GB, 7200-RPM, SATA 577972-001

Solid state drive, 128-GB, SATA 606971-001

Solid state drive, 80-GB, SATA 583004-001

Before removing the hard drive or solid state drive, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

6. Remove the keyboard (see Keyboard on page 47).

To remove the hard drive or the solid state drive:

1. Loosen the Phillips PM2.5×10.0 captive screw (1), and remove the 2 Phillips PM2.0×3.0
screws (2) that secure the drive assembly to the base enclosure.
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2. Use the Mylar tab to slide the assembly to the right (3) to disconnect it, and remove the
assembly (4).

3. Remove the mounting bracket.

On a hard drive:

a. Remove the 4 Phillips PM3.0×3.0 screws (1) that secure the hard drive bracket to the hard
drive.

b. Using the Mylar tab, lift the bracket (2) away from the hard drive.

– or –

On a solid state drive:

a. Remove the 4 Phillips PM2.0×3.0 screws (1) that secure the solid-state drive bracket to the
solid state drive.

b. Lift the solid-state drive module (2) to remove it.

Component replacement procedures 51



Reverse this procedure to install a hard drive or solid state drive.
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WLAN module

Description Spare part number

Broadcom 4312G 802.11b/g WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter (BT3.0+HS
ready)

575920-001

Broadcom 43224 802.11a/b/g/n 2x2 WiFi Adapter  

● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

518434-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Argentina, Armenia, Aruba,
Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium,
Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Italy, the Ivory Coast, Jamaica, Japan, Jordan,
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People’s
Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand,
Togo, Tonga, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

518434-002

Intel Centrino Wireless-N 1000 802.11b/g/n 1x2  

● For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan,
Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia, Brazil, Brunei, Bulgaria,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland,
France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala,
Haiti, Herzegovina, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel,
Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon,
Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico,
Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Nigeria, Norway, Oman, Panama, Paraguay, the People’s Republic China, Peru,
the Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi Arabia,
Senegal, Serbia, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, the United Arab
Emirates, the United Kingdom, Uruguay, the U.S. Virgin Islands, the United States, Venezuela,
and Vietnam

572520-001

● For use in Russia and Ukraine 585984-001

Broadcom 4312G 802.11b/g WiFi Adapter  
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Description Spare part number

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and the U.S.
Virgin Islands

504593-003

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Cape Verde, the Central African Republic, Chad, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia,
Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia,
Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's
Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan,
Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized
for use in the device by the governmental agency that regulates wireless devices in your country or
region. If you replace the module and then receive a warning message, remove the module to restore
device functionality, and then contact technical support through Help and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

6. Remove the following components:

a. Keyboard (see Keyboard on page 47)

b. Hard drive or solid state drive (see Mass storage devices on page 50)
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Remove the WLAN module:

1. Pull back the Mylar shield (1) from WLAN module.

2. Disconnect the wireless antenna cables (2) from the terminals on the WLAN module.

3. Remove the 2 Phillips PM2.0×3.0 screws (3) that secure the WLAN module to the system board.
(The module tilts up.)

4. Remove the WLAN module (4) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (5) to prevent incorrect insertion into the
WLAN module slot.

Reverse this procedure to install the WLAN module.
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SIM module

Description Spare part number

SIM module board (includes cable) 577923-001

Before removing the SIM module, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. Remove the SIM (see SIM on page 44).

6. Remove the keyboard (see Keyboard on page 47).

7. Remove the hard drive or solid state drive (see Mass storage devices on page 50).

Remove the SIM module:

▲ Disconnect the LIF cable (1) from the computer, and remove the SIM module (2).

Reverse this procedure to install the SIM module.
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Top cover

Description Spare part number

Top cover with TouchPad, black 577926-001

Top cover with TouchPad, red 598461-001

Top cover with TouchPad, blue 598462-001

Before removing the top cover, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

6. Remove the memory module (see Memory module on page 45).

7. Remove the keyboard (see Keyboard on page 47).

8. Remove the hard drive or solid state drive (see Mass storage devices on page 50).

9. Remove the WLAN module (see WLAN module on page 53)

Remove the top cover:

1. Turn the device upside down, with the front toward you.

2. Use a thin, flat tool to release the 4 rubber device feet.
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3. Remove the 4 Torx T8 2.5×5.0 screws (1), and the 4 Phillips PM2.0×3.0 screws (2) that secure
the top cover to the base enclosure.

4. Turn the device right-side up, with the front toward you.

5. Open the device as far as possible.

6. Release the ZIF connector (1) that connects the button board cable to the system board.

NOTE: If not done when removing the WLAN module on page 53, release any WLAN cable
routed along the top cover.

7. Remove the following screws that secure the top cover to the base enclosure:

● (2) - 5 Phillips PM2.0×6.0

● (3) - 1 Phillips PM2.0×2.5

8. Release the clips along the front edge of the top cover and open the front of the top cover (1)
enough to see the TouchPad and speaker cables.
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9. Lift the back edge of the top cover up and forward (2) to release the clips along the rear edge of
the top cover.

10. Release the ZIF connector (1) for the TouchPad button board cable, and disconnect the cable (2)
from the system board.

11. Disconnect the speaker cable (3) from the system board, and then remove the top cover.

Reverse this procedure to install the top cover.
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Speaker

Description Spare part number

Speaker assembly with cable 577967-001

Before removing the speaker assembly, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

6. Remove the memory module (see Memory module on page 45).

7. Remove the keyboard (see Keyboard on page 47).

8. Remove the hard drive (see Mass storage devices on page 50).

9. Remove the top cover (see Top cover on page 57).

Remove the speaker assembly:

1. Turn the top cover upside down, with the front toward you.

2. Remove the 2 Phillips PM2.0×3.0 screws (1) that secure the assembly to the top cover, and
remove the speaker assembly (2) from the top cover.

NOTE: If seated tight, work the speaker back and forth to release the speaker from the speaker
alignment pins (3).
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Reverse this procedure to install the speaker assembly.
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WWAN module

Description Spare part number

WWAN module, Qualcomm EV-DO HSPA (includes mounting bracket)

NOTE: Not supported by computers with Linux installed.

NOTE: Not supported by computers with the HD Enhanced Video Accelerator installed.

531993-001

CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized
for use in the device by the governmental agency that regulates wireless devices in your country or
region. If you replace the module and then receive a warning message, remove the module to restore
device functionality, and then contact technical support.

Before removing the WWAN module, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. Remove the SIM (see SIM on page 44).

6. Remove the following components:

a. Keyboard (see Keyboard on page 47)

b. Hard drive (see Mass storage devices on page 50)

c. Top cover (see Top cover on page 57)

Remove the WWAN module:

1. Disconnect the wireless antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the 2 Phillips PM2.0×4.0 screws (2) that secure the WWAN module (3) to the base
enclosure and mounting bracket. (The module tilts up.)
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3. Remove the WWAN module (3) by pulling the module away from the mini-card slot at an angle.

NOTE: The mounting bracket on the right side of the WWAN module is only used with the
WWAN module mini-card and secures to the base enclosure with a PM 2.0×2.0 screw.

Reverse this procedure to install the WWAN module.
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RTC battery

Description Spare part number

RTC battery 507707-001

Before removing the real-time clock (RTC) battery, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

6. Remove the Keyboard (see Keyboard on page 47).

7. Remove the Hard drive (see Mass storage devices on page 50).

8. Remove the Top cover (see Top cover on page 57).

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Detach the RTC battery (2) from the system board.

NOTE: The RTC battery is attached to the system board with double-sided tape.

Reverse this procedure to install the RTC battery.

64 Chapter 4   Removal and replacement procedures



Bluetooth module

Description Spare part number

Bluetooth module 537921-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

6. Remove the following components:

a. Keyboard (see Keyboard on page 47)

b. Hard drive (see Mass storage devices on page 50)

c. Top cover (see Top cover on page 57)

Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable (1).

2. Release the Bluetooth module from the adhesive pad to which it is affixed (2), and remove the
Bluetooth module.

Reverse this procedure to install the Bluetooth module.
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Power button board

Description Spare part number

Power button board with cable 598451-001

Before removing the power button board, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

6. Remove the following components:

a. Keyboard (see Keyboard on page 47)

b. Hard drive (see Mass storage devices on page 50)

c. Top cover (see Top cover on page 57)

Remove the power button board:

1. Disconnect the power button board cable (1).

2. Remove the 3 Phillips PM2.0×2.0×7.0 broad head screws (2) that secure the power button board
to the base enclosure.

3. Remove the power button board (3).

Reverse this procedure to install the power button board.
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Display assembly

Description Spare part number

Display assembly (includes 1 webcam, 2 microphones, and 2 WLAN antenna with cables; WWAN antennas with cables
on select models)

● 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use with
webcam and WWAN option, black

598456-001

● 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use with
webcam and WWAN option, red

607178-001

● 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use with
webcam and WWAN option, blue

607180-001

● 25.7-cm (10.1-in), high-definition, AntiGlare, touch-screen display for use with
webcam, black

598454-001

● 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with
webcam and WWAN option, black

580616-001

● 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with
webcam and WWAN option, red

607182-001

● 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with
webcam and WWAN option, blue

607184-001

● 25.7-cm (10.1-in), high-definition, AntiGlare display assembly for use with
webcam

577969-001

● 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with
webcam and WWAN option, black

598455-001

● 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with
webcam and WWAN option, red

607177-001

● 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with
webcam and WWAN option, blue

607179-001

● 25.7-cm (10.1-in), WSVGA, AntiGlare, touch-screen display for use with
webcam

598453-001

● 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with webcam
and WWAN option, black

580615-001

● 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with webcam
and WWAN option, red

607181-001

● 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with webcam
and WWAN option, blue

607183-001

● 25.7-cm (10.1-in), WSVGA, AntiGlare display assembly for use with webcam 577968-001

Display bezel

● For use with touch screen with webcam 598460-001

● For use with non-touch screen with webcam 577929-001

Display hinge kit

(Includes left and right display panel hinges)

577930-001

Component replacement procedures 67



Description Spare part number

Touch screen LCD panel

● For use with high-definition display assembly 607113-001

● For use with WSVGA display assembly 607112-001

Webcam module 577927-001

Display panel/webcam cable

● For use in high-definition display assembly 577932-001

● For use in WSVGA display assembly 577931-001

Display cable kit includes the following cables: 577933-001

● WLAN antennas (2) with cables  

● Dual microphone with cable  

● WWAN antennas (2) with cables on select models  

Display back cover (includes logo)

● For use with touch screen, black 598457-001

● For use with touch screen, red 598458-001

● For use with touch screen, blue 598459-001

● For use with non-touch screen, black 577928-001

● For use with non-touch screen, red 606201-001

● For use with non-touch screen, blue 606970-001

Before removing the display assembly, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

6. Remove the following components:

a. Keyboard (see Keyboard on page 47)

b. Hard drive (see Mass storage devices on page 50)

c. WLAN module (see WLAN module on page 53)

d. Top cover (see Top cover on page 57)
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Remove the display assembly:

1. Disconnect the following cables and grounding tape from the system board and cable routing
clips:

(1) Display panel cable

(2) Display panel cable grounding tape

(3) WLAN cables

(4) WWAN cables (select models only)

(5) Microphone cable

CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other device
components.

2. Remove the 2 Phillips PM2.5×5.0 screws (1) that secure the display assembly to the device.

3. Remove the display assembly (2).
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4. If it is necessary to replace the display bezel, perform the following steps:

a. Remove the 4 Mylar screw covers (1) from the corners of the display bezel, and then remove
the 4 2.5×3.0 screws (2) that secure the display bezel to the back cover.

b. Flex the inside edges of the left and right sides (1), and then the top and bottom (2) of the
display bezel until the bezel disengages from the display enclosure.

c. Remove the display bezel (3).

NOTE: Tabs on the hinge covers (4) lock to insets on the base enclosure.

5. If it is necessary to replace the webcam module, perform the following steps:

a. Lift the webcam (1).
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b. Disconnect the webcam cable (2) from the webcam.

c. Remove the webcam.

6. If it is necessary to replace the non-touch display panel, perform the following steps:

a. Remove the 8 Phillips PM2.5×5.0 screws that secure the display panel to the display
enclosure.

b. Lift the bottom edge of the display panel up from the display back cover (1).

c. Disengage the display panel cable (2) from the left hinge clip.

d. Remove the display panel (3) from the display back cover.
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– or –

On touch-screen display assemblies:

a. Remove the 9 Phillips PM2.5×5.0 screws that secure the display panel to the display
enclosure.

b. Lift the top edge of the display panel up from the back cover (1).

c. Disengage the display panel cable (2) from the left hinge clip.

d. Disengage the touch-screen display board (3) from the snap hooks on the back cover.

CAUTION: Do not bend the cable when disengaging the touch-screen display board.

e. Release the touch-screen display board (4) from display back cover.

f. Remove the display panel from display back cover (5).
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7. If it is necessary to replace the display panel/webcam cable, use the following steps:

a. Turn the display panel over, and peel back the Mylar shield (1) on the back of the display
panel.

b. Lift the adhesive strip (2) that secures the cable to the back of the display panel, and
disconnect the display panel/webcam cable (3).
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c. Release the display panel/webcam cable (1) from the adhesive points (2) along the cable
route on the back of the display panel.

d. Remove the display panel/wedcam cable.

8. If it is necessary to replace the display hinges, perform the following steps:

a. Remove the 2 Phillips PM2.0×3.0 screws (1) that secure each hinge to the display panel.

b. Remove the hinges (2).

9. If it is necessary to replace the microphone receiver, perform the following steps:

a. Release the microphone receiver from the clip (1) that secures it to the display enclosure.
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b. Pull the receiver through the tabs (2), and remove the microphone receiver (3).

10. If it is necessary to replace the wireless antennas and cables, perform the following steps:

a. Detach the WLAN antennas (1) and the WWAN antennas (2) from the adhesive on the
back cover, and then route the cables through the clips (3) that secure them to the display
back cover.

b. Remove the wireless antennas and cables.

Reverse this procedure to reassemble and install the display assembly.
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System board

Description Spare part number

System board (includes processor and replacement thermal material)  

● Includes Intel Atom N470 1.83-GHz processor, 512-KB Level 2 cache, 667-MHz front-side bus
(FSB)

598449-001

● Includes Intel Atom N470 1.83-GHz processor, 512-KB Level 2 cache, 667-MHz front-side bus
(FSB) for use in the People's Republic of China

598450-001

● Includes Intel Atom N450 1.66-GHz processor, 512-KB Level 2 cache, 667-MHz front-side bus
(FSB)

598447-001

● Includes Intel Atom N450 1.66-GHz processor, 512-KB Level 2 cache, 667-MHz front-side bus
(FSB) for use in the People's Republic of China

598448-001

Before removing the system board, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

6. Remove the following components:

a. Keyboard (see Keyboard on page 47)

b. Hard drive (see Mass storage devices on page 50)

c. Top cover (see Top cover on page 57)

d. Display assembly (see Display assembly on page 67)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● WLAN module (see WLAN module on page 53)

● WWAN module, if included (see WWAN module on page 62)

● Bluetooth module (see Bluetooth module on page 65)

Remove the system board:

1. Remove the Phillips PM2.0×3.0 screw (1) that secures the bracket over the audio connectors to
the base enclosure, and then remove the bracket (2).

2. Remove the bracket that sec
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3. On models with the WWAN option installed remove the Phillips PM2.0×2.0 screw (3) that
secures the WWAN bracket to the base enclosure, and then remove the WWAN bracket (4).

4. Grasp the system board at the midpoint of the board (1), and tilt it up to the left (2).

5. Remove the audio connector cover and pull the system board (3) out to the right at an angle to
remove the system board from the base enclosure.

Reverse the procedure to install the system board.
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Fan and heat sink assembly

Description Spare part number

Fan and heat sink assembly (includes replacement thermal material) 598452-001

NOTE: To properly ventilate the device, allow at least a 7.6-cm (3-inch) clearance on the left side of
the device. The device uses an electric fan for ventilation. The fan is controlled by a temperature sensor
and is designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is displaced
through the ventilation grill located on the left side of the device.

Before removing the fan and heat sink assembly, follow these steps:

1. Shut down the device. If you are unsure whether the device is off or in Hibernation, turn the device
on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the device.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the device.

4. Remove the battery (see Battery on page 43).

5. If your device has WWAN capability, remove the SIM (see SIM on page 44).

6. Remove the following components:

a. Keyboard (see Keyboard on page 47)

b. Hard drive (see Mass storage devices on page 50)

c. Top cover (see Top cover on page 57)

d. WLAN module (see WLAN module on page 53)

e. Display assembly (see Display assembly on page 67)

f. System board (see System board on page 76)

Remove the fan and heat sink assembly:

1. Turn the system board upside down.
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2. Disconnect the fan cable from the system board.

3. Turn the system board right side up.

4. Loosen the 4 Phillips PM2.5×5.0 captive screws (1) that secure the fan and heat sink assembly to
the system board.

NOTE: The screws are numbered 1 through 4. Follow this order when removing the screws.

5. Remove the Phillips PM2.0×3.0 screw (2) that secures the fan and heat sink assembly to the
system board.

6. If necessary, work the heat sink back and forth to release the heat sink from the thermal paste (3)
on the processor.

7. Remove the fan and heat sink assembly (4).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the fan and heat sink
assembly and the system board each time the fan and heat sink assembly is removed. Thermal paste is
used on the processor (1). Replacement thermal material is included with all fan and heat sink
assembly, and system board spare part kits.

Component replacement procedures 79



Reverse this procedure to install the fan and heat sink assembly.
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5 Computer Setup

Computer Setup in Windows 7
To view the drives installed on the computer, select Start > Computer.

On models with a secondary hard drive (drive D), the optical drive becomes drive E. The next drive
added to the system, such as a new USB drive, will be assigned the next available drive letter.

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer.

2. Before your operating system opens and while the “Press the ESC key for Startup Menu” message
is displayed in the lower-left corner of the screen, press esc.

3. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.
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To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.

4. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

use the tab key and the arrow keys to select File > Ignore changes and exit, and then
press enter.

– or –

● To save your preferences and exit Computer Setup menus, click the Save icon in the lower-
left corner of the screen, and then follow the instructions on the screen.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing esc while the
"Press the ESC key for Startup Menu" message is displayed in the lower-left corner of the screen.

2. Press f10 to enter BIOS Setup.

3. Use the arrow keys to select File > Restore defaults, and then press enter.
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4. When the confirmation dialog box opens, press f10.

5. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
changes and exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Computer Setup menus
The menu tables in this section provide an overview of the Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer.

● View specification information for the processor, cache
and memory size, and system ROM.

Set system date and time Change date and time

● Set date: MM:DD:YYYY

● Set time: HH:MM

System Diagnostics ● F1: System information

● F2: Start-up test

● F3: Run-in test

● F4: Hard disk test

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Administrator Tools

BIOS administrator password Enter, change, or delete a BIOS administrator password.

User Management (requires a BIOS administrator password)

Create New BIOS User Account password ● Select from a list of BIOS users.

● Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default).

User Tools

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of Disk
Sanitizer erase cycles from a list.

● Last Pass: Displays Disk Sanitizer Completion Report

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu

NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot options ● Set a Startup Menu delay in seconds.

● Set the MultiBoot Express Boot Popup delay in seconds.

● Enable/disable Custom Logo (disabled by default).

● Enable/display Display Diagnostic URL.

● Enable/disable SD card boot.

● Enable/disable floppy boot.

● Enable/disable PXE Internal NIC boot.

● Set the UEFI boot order: Windows Boot Manager.

● Set the legacy boot order:

◦ 1st boot device: Notebook hard drive

◦ 2nd boot device: USB floppy

◦ 3rd boot device: USB CD-ROM

◦ 4th boot device: USB hard drive

◦ 5th boot device: Notebook Ethernet

◦ 6th boot device: SD card
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Select To do this

Device configurations ● Enable Fn Key Switch

● Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:

◦ Use of a USB keyboard in Computer Setup even
when your operating system is not running.

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

● Enable/disable fan always on while connected to an AC
outlet.

● Enable/disable Data Execution Prevention (select models
only). When enabled, the processor can disable some
virus code execution, which helps to improve computer
security.

● Enable/disable LAN power saving mode.

● Set the SATA (Serial Advanced Technology Attachment)
device mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

● Enable/disable HP QuickLook.

● Enable/disable HP QuickLook preboot authentication on
HP QuickLook boot.

● Enable/disable HP QuickWeb.

● Enable/disable HP QuickWeb: Write Protect (disabled
by default).

● Enable/disable Intel® HT Technology.

● Enable/disable Wake on USB (disabled by default).

● Enable/disable Numlock state at boot: Off /On
(disabled by default).
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Select To do this

Built-in device options ● Enable/disable the wireless switch state.

● Enable/disable embedded WLAN device radio.

● Enable/disable Network Interface Controller (NIC).

● Enable/disable LAN/WLAN Switching (disabled by
default).

● Set the wake on LAN state.

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the integrated camera (webcam).

● Enable/disable Power Monitor Circuit.

● Enable/disable the audio device.

● Enable/disable the microphone.

● Enable/disable the internal speakers.

Port options Enable/disable USB port.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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Computer Setup in Windows Vista
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

● System Information

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

● Start-up Test—Verifies the system components needed for
starting the computer.

● Run-In Test—Runs a comprehensive check on system
memory.

● Hard Disk Test—Runs a comprehensive self-test on any
hard drive in the system.

● Memory Test—Runs a comprehensive test on any
memory installed in the computer.

● Battery Test—Runs a comprehensive test on any batteries
installed in the computer.

● Error Log—Displays a log file if any errors have
occurred.

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)
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Select To do this

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software Help.

NOTE: You must have a setup password to change this
setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu

NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Enable/disable MultiBoot (enabled by default).

● Set the Express Boot Popup delay in seconds.

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (disabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Enable/Disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

● Set the Legacy Boot Order.
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Device Configurations ● Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not running

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer

● Select a parallel port mode: ECP (Enhanced Capabilities
Port), standard, bidirectional, or EPP (Enhanced Parallel
Port).

● Enable/disable fan always on while connected to an AC
outlet (disabled by default).

● Enable/disable Data Execution Prevention (select models
only). When enabled, the processor can disable some
virus code execution, which helps to improve computer
security (disabled by default).

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)

NOTE: Availability of these options varies by computer
model.

● Enable/disable secondary battery fast charge (enabled
by default).

● Enable/disable HP QuickLook (enabled by default).

● Enable/disable Preboot Authentication on HP QuickLook
Boot (enabled by default).

● Enable/disable HP QuickWeb (enabled by default).

● Enable/disable HP QuickWeb Elevated Security
(disabled by default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable Wake on USB (enabled by default).

● Enable/disable Num lock state at boot (disabled by
default).

● Enable/disable TXT (Intel® Trusted Execution
Technology) (select models only; disabled by default).
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Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WLAN device radio (select
models only; enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Enable/disable the embedded Bluetooth® device radio
(enabled by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Enable/disable LAN Power Save (select models only).
When enabled, saves power by turning off the LAN
when not in use (enabled by default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the Notebook Upgrade Bay device
(enabled by default).

● Enable/disable the Power Monitor Circuit (enabled by
default).

● Enable/disable the audio devices (enabled by default).

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the microphone (enabled by default).

● Enable/disable the internal speakers (enabled by
default).
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Port Options (all are enabled by default) NOTE: All port options are enabled by default.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the ExpressCard slot.

● Enable/disable the Smart Card slot.

● Enable/disable the eSATA port.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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Computer Setup in Windows XP
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer.

2. Before your operating system opens and while the “Press the ESC key for Startup Menu” message
is displayed in the lower-left corner of the screen, press esc.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.
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3. Select the File, Security, Diagnostics, or System Configuration menu.

4. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

use the tab key and the arrow keys to select File > Ignore changes and exit, and then
press enter.

– or –

● To save your preferences and exit Computer Setup menus, click the Save icon in the lower-
left corner of the screen, and then follow the instructions on the screen.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing esc while the
"Press the ESC key for Startup Menu" message is displayed in the lower-left corner of the screen.

2. Press f10 to enter BIOS Setup.

3. Use the arrow keys to select File > Restore defaults, and then press enter.

4. When the confirmation dialog box opens, press f10.

5. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
changes and exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of the Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set system date and time Set or change the date and time on the computer.

● Set date: MM:DD:YYYY

● Set time: HH:MM

System Diagnostics ● F1: System information

● F2: Start-up test

● F3: Run-in test

● F4: Hard disk test

Restore Defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then exit
and restart the computer. Your changes go into effect when the
computer restarts.
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Security menu

NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Administrator Tools

Setup BIOS administrator password Enter, change, or delete a BIOS administrator password.

User Management (requires a BIOS administrator password)

Create New BIOS User Account password ● Select from a list of BIOS users.

● Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default).

User Tools

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of Disk
Sanitizer erase cycles from a list.

● Last Pass: Displays Disk Sanitizer Completion Report

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu

NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot options ● Set a Startup Menu delay in seconds.

● Set the MultiBoot Express Boot Popup delay in seconds.

● Enable/disable Custom Logo (disabled by default).

● Enable/display Display Diagnostic URL.

● Enable/disable SD card boot.

● Enable/disable floppy boot.

● Enable/disable PXE Internal NIC boot.

● Set the UEFI boot order: Windows Boot Manager.

● Set the legacy boot order:

◦ 1st boot device: Notebook hard drive

◦ 2nd boot device: USB floppy

◦ 3rd boot device: USB CD-ROM

◦ 4th boot device: USB hard drive

◦ 5th boot device: Notebook Ethernet

◦ 6th boot device: SD card
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Select To do this

Device configurations ● Enable Fn Key Switch

● Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:

◦ Use of a USB keyboard in Computer Setup even
when your operating system is not running.

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

● Enable/disable fan always on while connected to an AC
outlet.

● Enable/disable Data Execution Prevention (select models
only). When enabled, the processor can disable some
virus code execution, which helps to improve computer
security.

● Enable/disable LAN power saving mode.

● Set the SATA (Serial Advanced Technology Attachment)
device mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

● Enable/disable HP QuickLook.

● Enable/disable HP QuickLook preboot authentication on
HP QuickLook boot.

● Enable/disable HP QuickWeb.

● Enable/disable HP QuickWeb: Write Protect (disabled
by default).

● Enable/disable Intel® HT Technology.

● Enable/disable Wake on USB (disabled by default).

● Enable/disable Numlock state at boot: Off /On
(disabled by default).
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Select To do this

Built-in device options ● Enable/disable the wireless button state.

● Enable/disable embedded WLAN device radio.

● Enable/disable Network Interface Controller (NIC).

● Enable/disable LAN/WLAN Switching (disabled by
default).

● Set the wake on LAN state.

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the integrated camera (webcam).

● Enable/disable Power Monitor Circuit.

● Enable/disable the audio device.

● Enable/disable the microphone.

● Enable/disable the internal speakers.

Port options Enable/disable USB port.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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Computer Setup in SUSE Linux
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed in the lower-left corner of the screen.

2. Press f10 to enter BIOS Setup.

Computer Setup menus
The menu tables in this section provide an overview of the Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer.

● View specification information for the processor, cache
and memory size, and system ROM.

Set system date and time Change date and time

● Set date: MM:DD:YYYY

● Set time: HH:MM

System Diagnostics ● F1: System information

● F2: Start-up test

● F3: Run-in test

● F4: Hard disk test

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.
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Select To do this

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Administrator Tools

Setup BIOS administrator password Enter, change, or delete a BIOS administrator password.

User Management (requires a BIOS administrator password)

Create New BIOS User Account password ● Select from a list of BIOS users.

● Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default).

User Tools

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of Disk
Sanitizer erase cycles from a list.

● Last Pass: Displays Disk Sanitizer Completion Report

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu

NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot options ● Set a Startup Menu delay in seconds.

● Set the MultiBoot Express Boot Popup delay in seconds.

● Enable/disable Custom Logo (disabled by default).

● Enable/display Display Diagnostic URL.

● Enable/disable SD card boot.

● Enable/disable floppy boot.

● Enable/disable PXE Internal NIC boot.

● Enable/disable UEFI Boot Mode (disabled by default).

● Set the legacy boot order:

◦ 1st boot device: Notebook hard drive

◦ 2nd boot device: USB floppy

◦ 3rd boot device: USB CD-ROM

◦ 4th boot device: USB hard drive

◦ 5th boot device: Notebook Ethernet

◦ 6th boot device: SD card
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Select To do this

Device configurations ● Enable Fn Key Switch

● Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:

◦ Use of a USB keyboard in Computer Setup even
when your operating system is not running.

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

● Enable/disable fan always on while connected to an AC
outlet.

● Enable/disable Data Execution Prevention (select models
only). When enabled, the processor can disable some
virus code execution, which helps to improve computer
security.

● Enable/disable LAN power saving mode.

● Set the SATA (Serial Advanced Technology Attachment)
device mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

● Enable/disable HP QuickLook.

● Enable/disable HP QuickLook preboot authentication on
HP QuickLook boot.

● Enable/disable HP QuickWeb.

● Enable/disable HP QuickWeb: Write Protect (disabled
by default).

● Enable/disable Intel® HT Technology.

● Enable/disable Wake on USB (disabled by default).

● Enable/disable Numlock state at boot: Off /On
(disabled by default).
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Built-in device options ● Enable/disable the wireless switch state.

● Enable/disable embedded WLAN device radio.

● Enable/disable Network Interface Controller (NIC).

● Enable/disable LAN/WLAN Switching (disabled by
default).

● Set the wake on LAN state.

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the integrated camera (webcam).

● Enable/disable Power Monitor Circuit.

● Enable/disable the audio device.

● Enable/disable the microphone.

● Enable/disable the internal speakers.

Port options Enable/disable USB port.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.

Computer Setup in SUSE Linux 109



6 Specifications

Device specifications
 Metric U.S.

Dimensions

Depth 18.0 cm 7.09 in

Width 26.17 cm 10.30 in

Height (at front, non-touch screen) 2.32 cm 0.91 in

Height (at front, touch screen) 2.48 cm 0.98 in

Weight

25.7 cm (10.1 in) non-touch screen display equipped with a
3-cell battery, 160-GB hard drive, 1-GB memory, WLAN
module, and 2 wireless antennas

1.2 kg 2.64 lb

25.7 cm (10.1 in) touch screen display equipped with a
3-cell battery, 160-GB hard drive, 1-GB memory, WLAN
module, and 2 wireless antennas

1.3 kg 2.86 lb

Input power

Operating voltage 18.5 V dc, 13.5 W

Operating current 0.73 A

Temperature

Operating 0°C to 35°C 32°F to 95°F

Non-operating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Non-operating 5% to 95%

Shock

Non-operating 200 g, 2 ms, half-sine

Operating 125 g, 2 ms, half-sine

Random vibration
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 Metric U.S.

Operating 0.75 grms

Non-operating 1.50 grms

Maximum altitude (unpressurized)

Operating -15.24 to 3,048 m -50 to 10,000 ft

Non-operating -15.24 to 12,192 m -50 to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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25.7-cm (10.1-in), high-definition, 16:9, AntiGlare
display specifications

Dimensions

Height 12.52 cm (4.93 in)

Width 22.27 cm (8.77 in)

Diagonal 25.55 cm (10.06 in)

Number of colors 262,144

Contrast ratio 400:1 (typical)

Refresh rate 60 Hz

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.1630 mm

Format 1366 x 768, 16:9

Configuration RGB vertical stripe

Backlight LED

PPI 156

Viewing angle ±30° horizontal, ±10° vertical (typical)
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25.7-cm (10.1-in), WSVGA, AntiGlare display
specifications

Dimensions

Height 12.52 cm (4.93 in)

Width 22.27 cm (8.77 in)

Diagonal 25.55 cm (10.06 in)

Number of colors 262,144

Contrast ratio 400:1 (typical)

Refresh rate 60 Hz

Brightness 200 nits (typical)

Pixel resolution

Pitch (H × V) 0.2175 × 0.2088 mm

Format 1024 × 600

Configuration RGB vertical stripe

Backlight LED

PPI 117 (H)/122 (V)

Viewing angle ±30° horizontal, ±10 vertical (typical)
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Hard drive specifications
 320 GB* 250 GB* 160 GB*

Dimensions

Height 9.5 mm (0.37 in) 9.5 mm (0.37 in) 9.5 mm (0.37 in)

Width 70 mm (2.75 in) 70 mm (2.76 in) 70 mm (2.76 in)

Weight 115 g (4.06 oz) 115 g (4.06 oz) 115 g (4.06 oz)

Interface type ATA-8, SATA 2.6, 3.0 Gb/s, NCQ

Transfer rate (synchronous, maximum) 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.5 ms 1.5 ms 1.5 ms

Average 11.0 ms 11.0 ms 11.0 ms

Maximum 22.0 ms 22.0 ms 22.0 ms

Logical blocks 625,142,448 488,397,168 312,581,808

Disc rotational speed 7200 rpm 7200 rpm 7200 rpm

Operating temperature (case) 0°C to 60°C (32°F to 140°F)

* 1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Solid state drive specifications
Performance

Sequential read (maximum) 250 MB/s

Sequential write (maximum) 70 MB/s

Characteristics

Interface SATA revision 2.6

Flash type MLC (LBG) NAND

Flash capacity 60 GB, 128 GB

Features ATA Security; ATA-7 ;SATA 2.6; DIPM

Electrical specifications

DC supply voltage 5.0 V ±5%

Standby current 130 mA (typical)

Active current Read = 210.1 mA (average)

Write = 225.9 mA (average)

Environmental specifications

Operating temperature 0°C to +70°C (32°F to 158°F)

Storage temperature -55°C to +95°C (-67°F to 203°F)

Operating altitude up to 24,384 m (80,000 feet)

Humidity 5% to 90% non-condensing

Shock 1500 g

Vibration (operating) 20 g peak, 10~2000 Hz

Physical specifications

Connector 7+15 pin SATA connector

Weight 86 g (3.03 oz)

Dimensions (height  × width) 9.5 × 70 mm (0.37 × 2.75 in)

Regulations and compliance RoHS, China RoHS, SGS ROHS, FCC, CE
UL – PCB Only
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System resource specifications
You can use Device Manager to get a graphical view of the system resources that control how the
devices work on the computer. System resources you can access from Device Manager are direct
memory access (DMA) channels, input/output (I/O) ports, interrupt request (IRQ) lines, and memory
addresses.

If two devices require the same resource and create a device conflict, you can manually change the
resource settings in Device Manager to be sure each setting is unique.

CAUTION: Improperly changing resource settings can disable your hardware and cause your
computer to malfunction or become inoperable. Only users who have expert knowledge of computer
hardware and hardware configurations should change resource settings.

To view resource settings in Windows 7 and Windows Vista:

1. Select Start > Computer.

2. Click System properties near the top of the Computer folder.

3. On the left, click Device Manager.

4. On the View menu, click one of the following:

● Resources by type

● Resources by connection

To view resource settings in Windows XP:

1. Select Start > My Computer, or double-click My Computer on the desktop.

2. Under System Tasks, click View system information.

3. In the System Properties window, select the Hardware tab.

4. Click Device Manager.

5. On the View menu, click one of the following:

● Resources by type

● Resources by connection
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7 Backup and recovery

Windows 7 backup and recovery
To protect your information, use Windows® Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only), or
create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only)

● Backing up individual files and folders

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up
Recovery after a system failure is as complete as your most current backup. You should create system
repair discs (select models only) and your initial backup immediately after software setup. As you add
new software and data files, you should continue to back up your system on a regular basis to maintain
a reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
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Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Recovering
In case of system failure or instability, the computer provides the following tools to recover your files.

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use f11 recovery tools to recover your original hard drive image. The
image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system.

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from a
backup.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. select Start, right-click
Computer, click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 Operating System Operating System DVD and the Driver
Recovery disc (both purchased separately). For additional information, contact technical support
by selecting Start > Help and Support > Contact support.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press f11 for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

NOTE: Windows 7 provides additional recovery tools through the operating system. For additional
information, go to Help and Support.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows 7
Operating System DVD to reboot the computer and repair the operating system. For additional
information, contact technical support by selecting Start > Help and Support > Contact
support.
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Windows Vista backup and recovery
Use the instructions in this section if Windows Vista is installed on your computer.

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

Windows Vista® provides the following advanced backup and recovery options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For instructions on these procedures, go to Help and Support.

Backing up
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
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The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optional external optical drive you use.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optional external optical
drive.

To create a backup using Backup and Restore Center, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.
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Recovering
In case of system failure, use the f11 recovery tool to recover your original hard drive image.

NOTE: The image includes the Windows® operating system and software programs installed at the
factory.

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from a
backup.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, click Start >
Computer.

NOTE: If the HP Recovery partition has been deleted, you will need to recover your operating
system and programs using the Windows Vista Operating System and the Driver Recovery discs
(purchased separately). For additional information, contact technical support by selecting Start >
Help and Support > Contact support.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

4. Press f11 while the “Press f11 for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

NOTE: Windows Vista provides additional recovery tools through the operating system. For
additional information, go to Help and Support.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista
Operating System DVD to reboot the computer and repair the operating system. For additional
information, contact technical support by selecting Start > Help and Support > Contact
support.

122 Chapter 7   Backup and recovery



Windows XP backup and recovery
Use the instructions in this section if Windows XP is installed on your computer.

To protect your information, use the Windows® Backup utility to back up files and folders or create
recovery points. In case of system failure, you can use the backup files to restore your computer.

NOTE: Windows Backup utility is available only on the notebooks with the Windows XP Professional
operating system. If your notebook has Windows XP Home, you can back up your personal files to a
USB external hard drive (purchased separately).

Windows XP Professional provides the following advanced backup and recovery options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups (select models only)

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For instructions on these procedures, go to Help and Support.

Backing up
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

In Windows XP Professional, use the Windows Backup utility to create a backup. Click Start > All
Programs > Accessories > System Tools > Backup. Follow the on-screen instructions to back
up your files.

In Windows XP Home, copy data files to a USB external hard drive (purchased separately).

Recovering
In case of system failure or instability, use the Operating System disc and the Driver Recovery discs that
are included with the computer to recover your operating system and programs.

CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system as well as software and drivers. Software, drivers, and updates
not installed by HP must be manually reinstalled. Personal files must be restored from a backup.

1. If possible, back up all personal files.

2. Shut down the computer.

3. Insert the Operating System disc into an optional external optical drive.
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4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.

NOTE: For additional information, go to Help and Support.
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SUSE Linux backup and recovery
Use the instructions in this section if SUSE Linux SLED 11 is installed on your computer.

To protect your information, back up your files and folders. Then if the system fails, you can restore
your important files from copies. You can also use the options listed in this section to restore the
operating system and programs that were installed at the factory.

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the original operating system and HP programs and drivers that were installed at
the factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal
files must be restored from a backup.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. Restart the computer, and then press f11 while the “Press <F11> for recovery” message is
displayed on the screen.

3. Follow the on-screen instructions.
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8 Connector pin assignments

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground

The USB+ power port on the right side of the computer powers HP USB external devices (see Right-side
components on page 11). The port provides a minimum of 4.75 V measpin on the ured at the USB
connector under a continuous 2.5-A load. The port is capable of 3 A for <1 ms.

The USB + power port is identified by a 3.5 mm diameter key jack, which supports the pin on the USB+
power cable for HP external devices.

NOTE: The standard USB ports on the left side on the computer provide a minimum of 4.75 V under
a continuous 0.5-A load only.
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9 Power cord set requirements

The wide range input feature of the device permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the device meets the requirements for use in the country
or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the device is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the device.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).

134 Chapter 10   Recycling



4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter

identifying 17
AC adapter, spare part

number 28
antenna

removal 75
spare part number 27, 68

antennas 16
applications key, Windows 9
audio-in (microphone) jack 11
audio-out (headphone) jack 11
audio-in jack

pin assignments 126
audio-out jack

pin assignments 127

B
backing up 117, 120, 123
Backup and Restore 117, 118
base enclosure, spare part

number 25
battery

removal 43
spare part number 25, 43

battery bay 14
battery light 12
battery release latches 14
battery, identifying 17
BIOS administrator password 92
Bluetooth module

removal 65
spare part number 24, 65

boot options 85, 93, 101, 107
boot order 85, 93, 101, 107
built-in device

audio devices 95
Bluetooth device radio 95
fingerprint reader 95

internal speakers 95
LAN/WLAN switching 95
microphone 95
modem 95
Network Interface Controller

(LAN) 95
Notebook Upgrade Bay 95
Power Monitor Circuit 95
Wake on LAN 95
wireless button 95
WLAN device radio 95

built-in device options 95
buttons

power 8
QuickLook 8
QuickWeb 8
TouchPad 6

C
cables, service considerations 36
caps lock light, identifying 7
carrying handle

spare part number 29
carrying handle, identifying 15
chipset, product description 1
components

additional hardware 17
bottom 14
display 13
front 10
left-side 12
right-side 11
top 6

Computer Setup
File menu 83, 90, 99, 104
navigating and

selecting 81, 88, 97
restoring factory

settings 82, 89, 98

Security
menu 84, 92, 100, 106

System Configuration
menu 85, 93, 101, 107

connector, power 12
connectors

service considerations 36
cord, power 17

D
device configurations 94
device feet

locations 42
spare part number 42

device specifications 110
disk sanitizer 92
diskette drive

precautions 37
product description 2

display assembly
removal 67
spare part number 20, 67

display back cover
illustrated 27, 68

display bezel
illustrated 26, 67
removal 70
spare part number 26, 67

display cable kit, spare part
number 27, 68

display component recycling 133
display components 13
display enclosure

spare part number 27, 68
Display hinge kit, spare part

number 27, 67
display hinge, removal 74
display panel

illustrated 27, 68

Index 139



display panel/webcam cable
spare part number 27, 68

display specifications 112, 113
drive light 10
DriveLock password 92
DriveLock, automatic 92
drives

boot order 85, 101, 107
preventing damage 37

drives, boot order 93

E
electrostatic discharge 38
embedded numeric keypad keys,

identifying 9
esc key, identifying 9
Ethernet, product description 2
Execution Disable 94
external media cards, product

description 3
external monitor port

pin assignments 128
external monitor port,

identifying 12

F
fan

removal 78
spare part number 78

feet
locations 42
spare part number 42

File menu 83, 90, 99, 104
fn key, identifying 9
function keys, identifying 9

G
graphics, product description 1
grounding equipment and

methods 40

H
hard drive

precautions 37
product description 1
spare part number 22, 50
specifications 114

headphone jack
pin assignments 127

HP QuickLook 94
HP SpareKey enrollment 92

I
internal microphones,

identifying 13

J
jacks

audio-in (microphone) 11
audio-out (headphone) 11
RJ-45 (network) 11

K
keyboard

product description 3
removal 47
spare part number 20, 47

keys
esc 9
fn 9
function 9
keypad 9
Windows applications 9
Windows logo 9

L
labels

service tag 14
LAN Power Save 95
language, changing in Computer

Setup 93
latches, battery release 14
legacy support,

USB 81, 86, 88, 94, 97, 102
, 104, 108

lights
battery 12
caps lock 7
drive 10
power 7
QuickLook 7
QuickWeb 7
webcam 13
wireless 10

M
mass storage device

product description 1
spare part number 22

memory module
product description 1
removal 45
spare part number 25, 45

memory module compartment cover
removal 45

memory module compartment,
identifying 14

microphone assembly, spare part
number 27, 68

microphone jack
pin assignments 126

microphones, internal 13
model name 1
modem, product description 2
monitor port

pin assignments 128
monitor port, external 12

N
network jack

pin assignments 129

O
operating system, product

description 3
optical drive, product

description 2

P
packing guidelines 39
panels, product description 1
parallel port mode 94
passwords 84, 92, 100, 106
pin assignments

audio-in jack 126
audio-out jack 127
external monitor port 128
headphone jack 127
microphone jack 126
monitor port 128
network jack 129
RJ-45 jack 129
Universal Serial Bus (USB)

port 130
plastic parts 36
pointing device

product description 3
port options

1394 port 96
eSATA port 96
ExpressCard slot 96
flash media reader 96
parallel port 96
serial port 96
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Smart Card slot 96
USB port 96

ports
external monitor 12
product description 3
USB 11, 12

power button board
spare part number 66

power button, identifying 8
power connector, identifying 12
power cord

set requirements 131
spare part number 28

power cord, identifying 17
power light, identifying 7
power requirements, product

description 3
processor, product description 1
product description

audio 2
chipset 1
diskette drive 2
Ethernet 2
external media cards 3
graphics 1
hard drive 1
keyboard 3
mass storage device 1
memory module 1
modem 2
operating system 3
optical drive 2
panels 1
pointing device 3
ports 3
power requirements 3
processors 1
product name 1
security 3
serviceability 4
solid state drive 2
wireless 2

product name 1
product name and number,

computer 14

Q
QuickLook button, identifying 8
QuickLook light, identifying 7
QuickWeb button, identifying 8

QuickWeb light, identifying 7

R
recovering 119, 122, 123
release latches, battery 14
removal/replacement

preliminaries 36
procedures 41

restore security defaults 96
restore the factory settings 90
RJ-45 (network) jack,

identifying 11
RJ-45 jack

pin assignments 129
RTC battery

removal 64
spare part number 24, 64

rubber kit, spare part number 28

S
SATA (Serial Advanced Technology

Attachment) devices
AHCI (Advanced Host Controller

Interface) 94
IDE (Integrated Drive

Electronics) 94
screw kit

spare part number 29
scrolling regions, TouchPad 6
SD Card Reader 11
Secondary Battery Fast

Charge 94
security cable slot, identifying 11
Security menu

always prompt for HP SpareKey
enrollment 92

Automatic DriveLock 92
change password 92
Disk Sanitizer 92
DriveLock 92
fingerprint reader reset 92
HP Sparekey 92
HP Sparekey enrollment 92
password policy 92
set up BIOS administrator

password 92
System IDs 92

security, product description 3
serial number 18, 41
serial number, computer 14

service considerations 36
service tag 14, 18, 41
serviceability, product

description 4
set security level 96
setup utility

File menu 83, 90, 99, 104
navigating and

selecting 81, 88
restoring factory

settings 82, 89, 98
Security

menu 84, 92, 100, 106
System Configuration

menu 85, 93, 101, 107
SIM

removal 44
slots

security cable 11
solid state drive

product description 2
spare part number 22, 50
specifications 115

speaker assembly
illustrated 21
spare part number 21

speakers 10
specifications

device 110
display 112, 113
hard drive 114
solid state drive 115
system resources 116

static-shielding materials 40
switch, wireless 10
system board

removal 76
spare part number 24, 76

System Configuration
menu 85, 93, 101, 107

system date and
time 83, 90, 99, 104

system diagnostics 90
system fan 86, 94, 102, 108
system IDs 92
system

information 83, 90, 99, 104
system information key 9
system resources 116
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T
tools required 36
top cover

removal 57
spare part number 21, 57

TouchPad
buttons 6
identifying 6
scrolling regions 6

TPM Embedded Security 92
transporting guidelines 39
TXT (Intel® Trusted Execution

Technology) 94

U
Unified Extensible Firmware

Interface (UEFI) mode 93
USB board

spare part number 65
USB legacy

support 81, 86, 88, 94, 97
, 102, 104, 108

USB port
pin assignments 130

USB ports, identifying 11, 12

V
vents, identifying 12, 14
video, recording 13
Virtualization Technology 94

W
webcam 13
webcam light, identifying 13
webcam module

illustrated 27, 68
removal 70
spare part number 27, 68

Windows applications key,
identifying 9

Windows logo key, identifying 9
wireless antenna

removal 75
spare part number 27, 68

wireless antennas 16
wireless light 10
wireless module, product

description 2
wireless switch 10

WLAN module
removal 53
spare part number 53

workstation guidelines 39
WWAN module

removal 62
spare part number 62

142 Index




	HP Mini 5102                                Maintenance and Service Guide
	Product description
	External component identification
	Top components
	TouchPad
	Lights
	Buttons
	Keys

	Front components
	Right-side components
	Left-side components
	Display components
	Bottom components
	Carrying handle
	Wireless antennas
	Additional hardware components

	Illustrated parts catalog
	Service tag
	Device major components
	Display assembly components
	Miscellaneous parts
	Sequential part number listing

	Removal and replacement procedures
	Preliminary replacement requirements
	Tools required
	Service considerations
	Plastic parts
	Cables and connectors
	Drive handling

	Grounding guidelines
	Electrostatic discharge damage
	Packaging and transporting guidelines
	Workstation guidelines
	Equipment guidelines



	Component replacement procedures
	Service tag
	Device feet
	Battery
	SIM
	Memory module
	Keyboard
	Mass storage devices
	WLAN module
	SIM module
	Top cover
	Speaker
	WWAN module
	RTC battery
	Bluetooth module
	Power button board
	Display assembly
	System board
	Fan and heat sink assembly


	Computer Setup
	Computer Setup in Windows 7
	Starting Computer Setup
	Using Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup

	Computer Setup menus
	File menu
	Security menu
	System Configuration menu


	Computer Setup in Windows Vista
	Starting Computer Setup
	Using Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup

	Computer Setup menus
	File menu
	Security menu
	System Configuration menu


	Computer Setup in Windows XP
	Starting Computer Setup
	Using Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup

	Computer Setup menus
	File menu
	Security menu
	System Configuration menu


	Computer Setup in SUSE Linux
	Starting Computer Setup
	Computer Setup menus
	File menu
	Security menu
	System Configuration menu



	Specifications
	Device specifications
	25.7-cm (10.1-in), high-definition, 16:9, AntiGlare display specifications
	25.7-cm (10.1-in), WSVGA, AntiGlare display specifications
	Hard drive specifications
	Solid state drive specifications
	System resource specifications

	Backup and recovery
	Windows 7 backup and recovery
	Backing up
	Recovering

	Windows Vista backup and recovery
	Backing up
	Recovering

	Windows XP backup and recovery
	Backing up
	Recovering

	SUSE Linux backup and recovery

	Connector pin assignments
	Audio‑in (microphone)
	Audio‑out (headphone)
	External monitor
	RJ‑45 (network)
	Universal Serial Bus

	Power cord set requirements
	Requirements for all countries and regions
	Requirements for specific countries and regions

	Recycling
	Battery
	Display

	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.5
  /CompressObjects /All
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings false
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Remove
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
    /Courier
    /Courier-Bold
    /Courier-BoldOblique
    /Courier-Oblique
    /Helvetica
    /Helvetica-Bold
    /Helvetica-BoldOblique
    /Helvetica-Oblique
    /Symbol
    /Times-Bold
    /Times-BoldItalic
    /Times-Italic
    /Times-Roman
    /ZapfDingbats
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 600
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.33333
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /CreateJDFFile false
  /SyntheticBoldness 1.000000
  /Description <<
    /ENU (FOR Acrobat 9 HPIE Screen Optimized PDF compatible with Sceenshots under 225 dpi)
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice


